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Apresentação

O documento apresentado tem o objetivo de mostrar detalhadamente 
as etapas de análise no cromatógrafo gasoso GC-CP3800 Varian, para 
que pesquisadores, alunos e estagiários possam utilizar a metodologia 
de análise de forma rotineira e obtenham resultados precisos e de boa 
qualidade para as pesquisas relacionadas a gases de efeito  
estufa (GEEs).

Erros de rotina são mostrados neste trabalho e suas correções e 
origens são discutidas para análises de metano e óxido nitroso, desde 
a injeção das amostras gasosas até a obtenção de cromatogramas e 
interpretação de resultados.

Os autores lançaram esta publicação enfatizando todos os aspectos 
técnicos para o funcionamento perfeito do cromatógrafo gasoso  
GC-CP3800 Varian.

,

Adriano Venturieri
Chefe-Geral da Embrapa Amazônia Oriental
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Passo a Passo para o Uso 
do Cromatógrafo Gasoso 
Modelo GC-CP3800 Varian 
para Análises de Gases de 
Efeito Estufa (GEEs)

Juliana Feitosa Felizzola
Cristiane Formigosa Gadelha da Costa
Steel Silva Vasconcelos 

Introdução 

Este guia esclarece o uso da cromatografia gasosa no GC-CP3800 
Varian para análise de variáveis associadas aos processos de emissão 
de gases de efeito estufa (GEEs). Os procedimentos destinam-se 
à avaliação do fluxo de metano (CH4), óxido nitroso (N2O) e gás 
carbônico (CO2) nas diversas matrizes ambientais: gases emitidos pelo 
solo, gases presentes na água e no ar.

A descrição e os procedimentos a seguir englobam linhas de estudo 
como a emissão de GEE em sistemas agropecuários, o balanço das 
emissões de GEE e a determinação de fatores de emissão, também 
para as áreas de produção de grãos, sendo considerada a utilização do 
mesmo equipamento. 

Neste documento é estabelecido um procedimento de operação padrão 
(POP) que não é considerado como um substituto do manual do 
equipamento GC-CP3800. Estudantes e a equipe técnica devem ser 
treinados pelos supervisores de operação e as metodologias de uso 
devem ser documentadas. Esse POP tem o objetivo de promover o uso 
seguro do GC-CP3800 para fins de pesquisa, levando em consideração 
cuidados como o uso de equipamentos de proteção individual (EPIs), 
procedimentos em caso de acidentes e operação do Varian GC-CP3800.
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Princípio da cromatografia gasosa 
(CG) com detector de chama  
(FID) e detector de captura de 
elétrons (ECD)

A cromatografia gasosa (CG) é uma técnica de separação e análise 
de misturas por interação dos seus componentes entre uma fase 
estacionária e uma fase móvel. De forma geral a técnica de CG é 
aplicável para separação e análise de misturas cujos constituintes sejam 
voláteis e que sejam termicamente estáveis.

A fase móvel em CG não interage com a amostra, apenas a carrega 
através da coluna, sendo assim usualmente referida como gás de 
arraste. Este deve ser inerte e não deve reagir com a amostra, fase 
estacionária ou superfícies do instrumento. Além disso, deve ser isento 
de impurezas que possam degradar a fase estacionária.

A amostra é injetada (injetor de amostra) e arrastada pela fase móvel 
(gás de arraste) através da coluna que contém a fase estacionária 
(coluna CG aquecida), na qual ocorre a separação da mistura. As 
substâncias separadas saem da coluna carreadas pela fase móvel e 
passam por um detector que  gera um sinal elétrico  proporcional à 
quantidade de  substâncias separadas na coluna. 

A função do detector situado na saída da coluna de separação é medir 
os componentes separados presentes no gás de arraste que eflui da 
coluna. O sinal de saída do detector entra num registrador que gera o 
cromatograma. Os dois detectores de ionização amplamente utilizados 
são: o detector de ionização de chama (FID) e o detector de captura 
de elétrons (ECD). A base do detector de ionização de chama é a de 
que o efluente da coluna, misturado com hidrogênio e ar, produz uma 
chama com energia suficiente para ionizar as moléculas do composto 
que tenham potenciais de ionização baixos. Os íons assim produzidos 
são coletados por eletrodos e a corrente iônica resultante é medida, 
ou seja, a detecção envolve o monitoramento da corrente produzida 
pela coleta desses portadores de carga. O FID é útil para análises de 
amostras orgânicas contaminadas com água, óxido de nitrogênio e 
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enxofre e exibe sensibilidade alta (~ 10-3 s. s-1), larga faixa linear de 
resposta (~107 ), além de possuir baixo custo e baixo ruído. No ECD, 
a amostra eluída da coluna passa sobre uma fonte radioativa emissora 
B, geralmente Ni63. Um elétron do emissor causa a ionização do gás 
carreador (frequentemente nitrogênio) e há produção de uma rajada de 
elétrons. Na ausência de espécies orgânicas, produz-se uma corrente 
constante entre o par de eletrodos em decorrência desse processo de 
ionização. Contudo, a corrente decresce na presença de moléculas 
orgânicas que contêm grupos funcionais eletronegativos que tendem 
a capturar elétrons, como os compostos halogenados, quinonas e 
grupos nitro que são detectados com alta sensibilidade. Esse detector é 
insensível a grupos funcionais como aminas, alcoois e hidrocarbonetos. 

Desvios e oscilações (identificados por meio do ruído do cromatograma) 
na linha base podem ser causados por problemas eletrônicos, impurezas 
e sujeiras nos gases e no detector.

O cromatógrafo GC-CP3800 Varian

Os principais componentes de um GC incluem: gases de arraste e gases 
para o detector, controladores de fluxos e válvulas, porta de injeção, 
coluna, forno, detector e um registrador de dados, como mostra a 
Figura 1.

Gases de arraste e gases para detectores

A fase móvel é composta por um gás inerte que passa pelo injetor e 
transporta os componentes da amostra para a coluna. O gás carreador 
frequentemente usado é o hélio, entretanto nitrogênio, argônio e 
ainda hidrogênio podem ser usados. A seleção do gás de arraste 
dependerá do tipo de detector, das características da coluna, da 
matriz da amostra, de condições de segurança e do custo. Se forem 
usadas colunas capilares, os gases mais utilizados são o hélio e o 
hidrogênio, que proporcionam alta eficiência em diferentes fluxos de 
gás programados. Se forem usadas colunas empacotadas, com o uso 
de nitrogênio é possível obter alta eficiência com baixos fluxos.
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Figura 1. Cromatógrafo gasoso.

Injetores

Existem duas classes de injetores: os de vaporização e os de injeção 
direta na coluna, os chamados on-column. Os injetores de vaporização 
podem ser do tipo split, splitless ou direct, e os injetores on-column, os 
do tipo injeção direta na coluna e injeção resfriada cooled. A função dos 
injetores é depositar as amostras dentro da coluna de forma homogênea 
para que se obtenham bandas finas e com uma boa discriminação entre 
os componentes da amostra. Os injetores split e splitless são aquecidos 
de forma que causam a vaporização das amostras antes de entrar na 
coluna. As temperaturas dos injetores são geralmente ajustadas para 
50 °C acima do ponto de ebulição do composto menos volátil da 
mistura. Os modos split/splitless determinam a quantidade de amostra 
que entra na coluna, de modo que o splitless é tipicamente usado para 
análises traço e transfere toda a quantidade de amostra para coluna, 
enquanto o split elimina para fora do injetor uma porção de amostra 
pré-determinada através do split vent e a outra porção para dentro 



13Passo a Passo para o Uso do Cromatógrafo Gasoso Modelo GC-CP3800 Varian para 
Análises de Gases de Efeito Estufa (GEEs)

da coluna. O injetor em modo split permite a entrada de amostras 
em concentrações que variam de 0,1-10 µg.µL-1 sem a saturação da 
coluna. A velocidade de injeção deverá ser rápida no modo split e lenta 
no modo splitless. 

Em injetores on-column, amostras líquidas entram diretamente na 
coluna ou passam pela sílica desativada chamada retention gap. As 
amostras são vaporizadas de acordo com o aumento da temperatura 
do injetor. Injetores on-column a frio são ideais para amostras sensíveis 
a calor ou amostras que tem grandes diferenças no processo de 
vaporização de injetores. Injeções diretas são feitas em colunas com 
grandes diâmetros (0,45 mm a 0,53 mm).

A maioria dos injetores tem um aparato chamado liner, que fica dentro 
do injetor e protege o corpo do injetor dos diversos tipos de amostras, 
mistura amostras e afeta a quantidade de amostras a ser injetada  
na coluna. 

Colunas

As colunas mais utilizadas em cromatografia gasosa são as colunas 
capilares de sílica fundida, que contém dentro uma fina camada de 
fase estacionária quimicamente ligada e poliamida na superfície externa 
para proteção. A escolha da coluna dependerá dos componentes da 
amostra, do tempo de vida da coluna e do custo.

Os componentes das amostras são primeiramente separados pela 
volatilidade do composto e temperatura estipulada. A fase estacionária 
deve ser estável acima de temperaturas requeridas para a separação. 
A maioria das colunas pode ser operada a temperaturas acima de 
350 °C por um período curto ou a 325 °C por período longo. Baixas 
temperaturas promovem boa separação, mas proporcionam tempos 
longos de corrida cromatográfica e largos picos. A temperatura do 
forno é progressivamente aumentada para liberar os compostos menos 
voláteis.
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A polaridade da coluna determina a capacidade de separar componentes 
polares e apolares. Fases estacionárias mais polares reterão compostos 
mais polares e fases apolares são conhecidas como mais estáveis e 
de longa vida, como as de 100% de metilpolisiloxano. A seletividade 
da coluna influencia a separação baseada em forças intermoleculares 
como as de dispersão, dipolo e ligações de hidrogênio. As forças de 
dispersão são aquelas que influenciam primeiramente em todas as fases 
estacionárias: pequenas moléculas e moléculas com baixa solubilidade 
tem baixa retenção em decorrência da dispersão.

Fases estacionárias são compostas de material constituído de 
polisiloxanos com metil, fenil, cianopropril ou trifloropropil. Os 
polisiloxanos que podem ser substituídos nas colunas são mais robustos 
e geralmente têm tempo de vida útil longo. Colunas constituídas de 
polisiloxanos modificados com arileno não são robustas, mas nelas 
ocorrem menos sangramentos (danos na estrutura química das colunas) 
e são ideais para serem usadas com espectrômetro de massas. Colunas 
constituídas com polietileno glicol (PEG) são conhecidas por separarem 
compostos em misturas difíceis, mas são facilmente degradáveis. 
Colunas com abertura tubular e camadas porosas (Plot) são apropriadas 
para análises de gases na temperatura ambiente. Fases estacionárias 
também podem ser ligadas ou não ligadas: as fases ligadas são mais 
estáveis e preferidas.

As colunas podem ter mais de 100 m de comprimento, com diâmetro 
entre 0,1 mm e 5 mm. Colunas longas com diâmetro pequeno 
proporcionam melhor resolução com custo mais alto do que colunas 
pequenas. 

Todas as fases estacionárias são degradadas quando expostas ao 
oxigênio e a altas temperaturas, entretanto algumas são mais sensíveis 
que outras. A exposição mínima deve ser mantida, garantindo um fluxo 
de alta pureza de gás hélio.
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Detectores

O cromatógrafo gasoso pode ser equipado com diferentes detectores, 
dois detectores ou mais com mais de uma coluna. Os diferentes 
detectores utilizados em cromatografia gasosa estão listados na  
Tabela abaixo.

Tabela 1. Tipos de detectores.

Detector Seletividade Limite de 
detecção

Faixa de 
concentração

Ionização de 
Chama (FID) Compostos orgânicos 100 pg 107

Condutividade 
Térmica (TCD)

Detector universal para 
compostos não orgânicos 1 ng 107

Captura de 
elétrons (ECD)

Haletos, nitratos, nitritos, 
peróxidos, anidros, 
organometálicos

50 fg 105

Nitrogênio-fósforo Nitrogênio, fósforo 10 pg 106

Fotometria de 
Chama (FPD)

Enxofre, fósforo, estanho, 
boro, arsênico, germânio, 
selênio, cromo

100 pg 103

Fotoionização 
(PID)

Alifáticos, aromáticos, 
cetonas, ésteres, aldeídos, 
aminas, heterocíclicos, 
organosulfúricos, 
organometálicos

2 pg 107

Espectrômetro de 
massa (MS)

Detector universal para 
compostos ionizáveis fg levels 107

Fonte: Manual CP3800 Varian.



16 Passo a Passo para o Uso do Cromatógrafo Gasoso Modelo GC-CP3800 Varian para 
Análises de Gases de Efeito Estufa (GEEs)

Sugestão de preparação de 
amostras

Padrões de calibração

O sinal produzido pelo detector é único para cada composto e deve ser 
comparado com padrão conhecido para identificação e quantificação. 
Padrões de calibração devem ser usados e injetados como as primeiras 
injeções do dia e antes de cada batelada de amostras. A menor 
concentração do padrão deve ser injetada primeiro e deverá ser igual ou 
ligeiramente abaixo da menor concentração esperada da amostra. O maior 
padrão deve ser igual ou maior do que o esperado para amostra de maior 
concentração. Os outros padrões devem estar entre as concentrações de 
menor valor e as de maior valor, devendo ser usado no mínimo 3 padrões 
(3 concentrações) para elaboração da curva de calibração.

Padrões internos 

Se as amostras forem diluídas e extraídas antes da análise, um conjunto 
de amostras “controle padrão” deverá passar pelo mesmo processo 
de extração para determinar os efeitos (as perdas) de preparação da 
amostra. Alternativamente, a cada amostra deve ser inserida uma 
quantidade conhecida de padrão e o cálculo da concentração final deve 
ser normalizado com base na concentração “interna” desse padrão. O 
uso de padrão interno corrige erros relacionados a volumes de injeção e 
é altamente recomendado por análises em cromatografia gasosa.

Revisão do software Varian 
CP3800

O cromatógrafo gasoso acoplado com o detector FID e ECD é 
controlado pelo software 5.51 da Workstation, usado para desenvolver 
e controlar métodos em corrida única ou para múltiplas injeções, ver 
resultados e modificá-los. As principais aplicações são acessadas 
via Star toolbar, mostradas na tabela abaixo. Esse toolbar também 
tem botões para métodos mais recentemente usados e resultados 
recentemente vistos.
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Todas as análises de amostras e métodos são controladas pelo System 
Control Application e essa janela deve permanecer aberta durante 
o funcionamento do método e durante standby. O System Control 
Toolbar está localizado abaixo do Star toolbar. A tabela abaixo mostra o 
System Control Toolbar e descreve a função de cada tecla. 

Tabela 2. Descrição do Star Toolbar.

Aplicação dos ícones Star Toolbar Objetivo

System Control –
Controle do Sistema

Monitorar o status do 
instrumento e controlar as 
análises de amostras. Essa 
janela se mantém aberta 
quando se está analisando  
ou em standby 

Method Editor – Editor de 
Método

Ver os parâmetros do método, 
aquisição e manipulação de 
dados

Automated File Edition – 
Edição de Sequências

Editar listas de amostras 
e sequências para injeção 
enquanto o instrumento usa 
outro método

Interactive Graphics –
Manipulação de 
Cromatogramas

Ver o cromatograma da 
amostra, fazer a integração de 
picos e recalcular resultados

GC Report Viewer – 
Relatório

Ver resultados e modificar 
relatórios, incluindo 
informações do método e  
da corrida

GC Batch Reporting –
Processamento de 
Relatórios

Criar relatório para um grupo 
de resultados

Quick Start – Início 
Rápido

Ativar o método e correr uma 
única amostra sem  
a necessidade de uma  
Sample List
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Tabela 3. System Control Tool Button.

System Control Tool Button Objetivo

Ilustração do Toolbar

Criar um novo arquivo, selecionar 
previamente um arquivo recém-criado 
ou editar notas para um arquivo

Ver, editar ou reativar um método

Ativar um método

Editar a informação de um módulo  
on-line (autosampler ou outro 
componente acoplado ao GC)

Injetar uma única amostra

Iniciar o recálculo da lista, da lista de 
amostras, da lista de sequências (a 
lista deve estar aberta)
Pausas na automação. A amostra que 
está correndo será completada e, após 
a automação, a lista de sequência 
será suspensa. Quando o ícone 
Begin for pressionado, a sequência 
será reiniciada do ponto no qual foi 
suspensa

Inicia a sequência de amostras

Imediatamente para a corrida e a 
sequência. Se o ícone Begin for 
ativado a corrida começa do início da 
lista de sequência das amostras
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Perigos em potencial

O cromatógrafo gasoso é conectado a diversos cilindros que devem 
ser mantidos em locais controlados e seguros. Quando os cilindros se 
encontram vazios (200 psi), devem ser devidamente fechados  
e lacrados.

 O gás hélio que flui na coluna cromatográfica é purificado e seco por 
um tubo conversor que contém zircônio. Esse tubo pode explodir se 
aquecido em presença de ar. Nunca desconecte o tubo conversor do 
forno se estiver em funcionamento.

O forno do cromatógrafo, o injetor e o detector operam em altas 
temperaturas, por isso não se deve abrir a porta do forno ou tentar 
acessar o detector ou o injetor enquanto o instrumento estiver  
em operação.

Equipamentos de proteção 
individual (EPIs)

Equipamentos de proteção individual como jalecos, luvas de nitrila 
ou látex, sapatos e óculos de proteção são obrigatórios para toda e 
qualquer atividade laboratorial (Figura 2).

Figura 2. EPIs.
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Procedimentos em caso de 
acidentes

Em caso de algum procedimento não usual no equipamento (cheiros, 
barulhos, etc.) contatar suporte técnico. Todos os incidentes devem 
ser comunicados ao técnico de instrumentação e ao responsável pelo 
equipamento e laboratório para que sejam tomadas ações e medidas  
de segurança.

O usuário do cromatógrafo gasoso com detector ECD (captura de 
elétrons) deve possuir um certificado da Comissão Nacional de Energia 
Nuclear (CNEN) e o laboratório deve ser autorizado por essa comissão 
para o uso de detectores com fontes radioativas. Qualquer incidente 
com esse tipo de detector deve ser comunicado ao responsável pelo 
laboratório, ao técnico de instrumentação e à CNEN. O monitoramento 
com detector Geiger (detector para radiação β), nesse caso, deve ser 
feito mensalmente.

Protocolo de uso

Procedimentos para ativação do cromatógrafo

1) Abertura dos gases de arraste (localizados na parte externa do 
laboratório).

•	Ar sintético, hidrogênio, nitrogênio e hélio.

•	Girar para o sentido anti-horário a válvula de abertura marcada em 
vermelho na Figura 3.
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2) Ligar o compressor na tomada 220 V e ativar colocando para baixo a 
chave vermelha em destaque na Figura 4. 

3) Acionar as chaves internas dos gases de arraste do laboratório 
(Figura 5) colocando na mesma direção da linha do gás.

4) Ligar o computador conectado ao cromatógrafo e acionar a chave da 
esquerda para direita para ligar o módulo do cromatógrafo GC-CP3800 
Varian (Figura 6). Obs.: Por segurança esperar 3 minutos para ligar  
o módulo1.

1Existem filamentos dentro do cromatógrafo GC que são danificados se o equipamento for aquecido 
sem os gases de arraste. 

Figura 3. Gases de arraste.

Figura 4.  Compressor de  

ar comprimido.
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•	Observar na tela do módulo a mensagem initializing e esperar a 
mensagem Waiting for network connection (Figura 7). Após essas 
mensagens, a tela de controle do sistema (system control) pode ser 
acionada no computador (Figura 8).

5) Acionamento do sistema de controle (conexão computador e módulo 

do cromatógrafo GC). Após todos os procedimentos de conexão do 
computador com o módulo do aparelho, seguir os seguintes procedimentos: 

Figura 6. Chave de acionamento 

localizada na parte superior  

do módulo do cromatógrafo  

GC-CP3800 Varian.

Figura 7. Painel de controle do 

módulo do cromatógrafo  

GC-CP3800 Varian.
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•	Criar ou copiar o método que vai ser utilizado para análise (Obs.: como 
existem métodos já configurados no computador, deve-se fazer cópia de 
um método preexistente para manter as informações de configuração). 

•	Clicar com botão direito do mouse no botão Iniciar do Windows e abrir o 
Windows Explorer → abrir a pastar Star → selecionar o método desejado 
(se possível um método de uma curva padrão com elevado R2), copiar 
(CTRL + C) e colar (CTRL + V) na própria pasta (pasta em que se 
encontra todos os métodos executados). Renomear o método com as 
informações de local de coleta e data [extensão (*.MTH)] (Figura 8).

Figura 8. Efetuação da cópia do método de analítico do cromatógrafo GC.

•	Abrir na tela do computador a janela (view) de controle do sistema (System 
Control – CP) de automação Star Chromatography Workstation para iniciar 
a conexão do computador com o  módulo do cromatógrafo GC (Figura 9).
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Figura 9. Tela de automação do software Star Chromatography Workstation no 

computador.

•	Esperar a estabilização das temperaturas do sistema do cromatógrafo GC 
antes de ativar um método. Verificar ao lado esquerdo da tela do System 
Control a cor do ícone ao lado das indicações Equilibrating e No fault. 
Adota-se: verde para sistema equilibrado e vermelho para não equilibrado. 
As temperaturas do forno da coluna, válvulas e detectores precisam 
atingir os padrões de temperaturas configurados no sistema2 (Figura 10).

•	 Iniciar os procedimento de limpeza da coluna necessários para eliminação 
de possíveis impurezas3. Executar o método de limpeza da coluna por  
2 horas nas seguintes temperaturas: Front-FID = 200 °C; Mid-FID = 
250 °C; Rear-ECD = 300 °C.

2A temperatura é um dos fatores determinantes para a separação eficiente dos compostos analisados. 
Cada detector possui no manual do aparelho uma temperatura considerada eficiente para uma boa 
eluição das amostras.
3Com o aquecimento do sistema em altas temperaturas (suportado pela coluna), resíduos existentes 
ao longo da coluna eluem e são eliminados em amostras de limpeza do aparelho (ar atmosférico = 
branco).
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Figura 10. a) Sistema 

de controle (System 

Control – CP) de 

automação Star 

Chromatography 

Workstation com 

as temperaturas do 

forno da coluna, 

detectores e válvulas 

não equilibradas para 

análise; b) Sistema 

totalmente equilibrado 

com destaque para os 

ícones de verificação 

das temperaturas.
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Procedimento de limpeza da coluna

1) Após a estabilização das temperaturas, abrir o método Limpeza 
da Coluna; System Control → File → Activate Method → Activate a 
System Control Method File → Selecionar o método de Limpeza da 
Coluna existente na pasta e clicar em Abrir (Figura 11). 

Figura 11. a) Comandos para acionamento do método de limpeza da coluna; b) Sistema do Star 

Chromatography Workstation com método de limpeza acionado. Detalhe para as temperaturas 

e para a confirmação do acionamento do método no lado direito superior da imagem.
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•	Criar planilha e pasta de amostras a serem analisadas: System Control 
File → Activate Method → New Samplelist → Create A New System 
Control Samplelist File → Star → Abrir a pasta Data → Inserir o nome  
da planilha com dados do local e data [extensão (*.SMP)] e  Salvar  
(Figura 12). Aparecerá na tela a Generic Samplelist4 e criar pasta → 
Data Files → Data Files Generation → New Folder (Inserir o mesmo 
nome criado para a planilha *.SMP) → Create A New Folder in the 
Selected Diretory → OK → verificar o nome da planilha para confirmar o 
procedimento e OK (Figura 13).

•	Digitar na Sample List os padrões em triplicata. Antes de passar o primeiro 
padrão, deve-se executar três brancos (procedimento de limpeza da coluna 
por segurança). Executar dois brancos entre cada padrão analisado e, 
antes de iniciar as amostras de campo, executar três brancos5 (Figura 14).

Figura 12. Comandos para criação da planilha de amostras a serem analisadas. 

Obs.: É importante fazer monitoramento dos brancos (ar atmosférico 
analisado no aparelho para servir de amostra de eliminação de resíduo), 
principalmente com a injeção de amostras muito concentradas, exigindo- 
-se uma quantidade maior de brancos. Para amostras de baixa e média 
concentração, após alguns testes em laboratório, verificou-se a necessidade 
de dois brancos entre cada amostra para o CH4  e um branco para o  N2O. 

4A planilha *.SMP criada precisa ser colocada em uma pasta, pois o programa não cria pastas 
automáticas para armazenamento de dados, o que faz com as informações salvas fiquem espalhadas 
na pasta central Star.
5Considerando a concentração elevada do último padrão após alguns testes, verificou-se a necessidade 
de eliminação de resíduo da coluna.
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Figura 13. a) Generic Samplelist à esquerda e comandos de criação da pasta para 

armazenamento das amostras analisadas; b) Finalização da criação da pasta analítica. 
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Etapa analítica

1) Ativação do método de análise.

•	Após as 2 horas de limpeza da coluna, ativar o método copiado segundo 
os procedimentos de ativação de método apresentado no tópico Limpeza 
da Coluna (Utilizar os mesmos comandos, trocando apenas o método de 
análise. Em lugar de limpeza da coluna.mth, ativar o método desejado) e 
esperar estabilizarem as temperaturas do sistema.

2) Ativação da planilha de amostras. 

•	Samplelist (Figura 14): Begin → OK; verifica local da pasta e nome → OK; 
no System Control aparecerá a mensagem Not Ready e depois Waiting. 
Injetar o primeiro branco quando aparecer a mensagem Waiting (Figura 15). 

Figura 14. Comandos para ativação da Samplelist. Destaque para o número de brancos a 

serem executados de acordo com tipo de amostra (padrão e/ou amostra de campo)6.

6Padrões de calibração de gases analíticos – N2O: A= 0,341; B=0,810; C=1,32 e CH4: A= 1,96; 
B=0,984; C=3,07, valores em ppm. 
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Figura 15. Tela do System Control com detalhe para as mensagens not ready e waiting à 

direita na parte superior da tela do computador.

Obs: Entre uma injeção e outra somente introduzir amostras quando 
aparecer a mensagem waiting. 

3) Injeção manual (on-column) de amostras no cromatógrafo  
GC-CP3800 Varian.

•	 Injetar no aparelho todos os padrões analíticos com a intercalação dos 
brancos necessários para calibração das curvas padrão de análise antes 
da injeção das amostras de campo7 (Figura 16).

Obs.: Os cilindros das misturas de padrão analítico de referência 
devem ser armazenados em local de temperatura homogênea e sem 
interferência de umidade. Todo o sistema da mistura padrão deve ser 
bem isolado em termos de septos e válvulas, pois não pode ocorrer 
entradas de ar nos cilindros por causa de contaminação. Por isso, 
é necessário realizar vistoria e manutenção nos septos em que se 
faz a introdução da seringa com agulha (ultra fine) para retirada do 
gás padrão. Os padrões analíticos devem ter alta pureza [Valores de 
referência para pureza de padrões (ISO 6141:2000): Baixa= 99,995 
(4.5); Média= 99,999 (5.0); Alta= 99,999 (6.0)].

7Após a introdução no aparelho de todos os padrões analíticos de alta pureza, pausar as injeções e 
calibrar a curva padrão de análise. A curva padrão precisa ser calibrada todas as vezes que se iniciar 
uma nova análise, pois de acordo com cada momento analítico poderá ocorrer variações no sistema 
(ex. corrente elétrica) o que vai interferir na acuraria dos dados analisados. É importante deixar 
sempre uma amostra a mais na Samplelist sem analisar, pois esta quando totalmente analisada fecha 
automaticamente.
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Figura 16. Cilindros de gases padrão de calibração do cromatógrafo GC e procedimento 

de manuseio.

•	 Introduzir a amostra no injetor manual (on-column) com auxílio de uma 
seringa de polipropileno de 10 ml8 que possui uma torneira de três vias. 
Para a injeção, deve-se abrir a torneira da seringa e, posteriormente, abrir 
a torneira do injetor e apertar no botão Start do painel de controle do 
módulo do cromatógrafo GC-CP3800 Varian (Figura 17).

Obs.: Para eliminar umidade residual da amostra usa-se drierite no 
injetor, que deve ser trocado periodicamente no início de uma nova 
análise. Para isso, retira-se com uma chave inglesa a porca e a 
conexão visualizada no ponto 1 e com o auxílio de um funil coloca-se 
o dessecante no ponto 2 (Figura 17). O drierite é um dessecante de 
alta qualidade9 feito a partir de 97% de sulfato de cálcio (CaSO4) e 3% 
cloreto de cobalto (CoCl2) anidro, quimicamente inerte, exceto para a 
água, e pode ser regenerado. A substituição deve ser feita quando a cor 
padrão (azul) ficar rosa por causa da absorção de traços de água (H2 O). 
Recomenda-se regeneração a 235 °C ou 450 F em mufla por 2 horas. 

8As amostras devem ser transferidas para as seringa 3 minutos antes das injeções para evitar trocas 
com o meio ambiente.
9W.A. Hammond Drierite CO. LTD. 
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Figura 17. Injeção de amostras no cromatógrafo GC-CP3800 Varian.

Calibração analítica

1) Executar a edição dos cromatogramas por meio dos procedimentos 
de integração cromatográfica para cálculo de área em volts min-1 ou 
mvolts sec-1. Para isso, deve-se abrir o método copiado para a execução 
da análise de resultados e calibração da curva padrão segundo as 
configurações preexistentes no método.

•	Clicar em View/Edit Chromatograms → abrir Interative Grafic; aparecerá a 
view → Open Mutiplus Data File → Fechar → Clicar em File e ir em Open 
Method → Star; selecionar o método copiado [extensão. *mth] → Open 
para ativar → Select Method Data Handing Section e escolher o canal de 
identificação – detector (Front; Middle; Rear) → OK; confirmar método 
ativado na parte superior da tela de automação10 (Figura 18).

2) Integração dos cromatogramas dos padrões analíticos. 

•	Com o método ativado, clicar em Open Chromatogram(s) → Open Mutiple 
Data Files → Star → Data; procurar a pasta de análise, abrir e selecionar 
7 padrões do menos concentrado para o mais concentrado com duplo 
clique → clicar em Channel e escolher o identificador de análise de 
resultados (Front=FID; Middle=FID; Rear=ECD) → Open File(s) → 
Reintegrate Now11 (Figura 19).

10O método precisa sempre estar ativado, pois o software precisa da curva padrão como referência 
para o cálculo de integração. No caso de calibração da curva padrão o software vai utilizar a curva que 
foi salva no método copiado.
11A linha de integração cromatográfica deve ser posicionada tangenciando a linha de base, para isso, deve-se 
arrastar a barra amarela e a linha localizada na parte inferior da tela do computador. Deve-se integrar cada 
pico antes de efetuar a calibração, para isso o software permite a integração de 7 picos por view de edição.
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Figura 18. Comandos para ativação do método de edição dos cromatogramas. Com 

destaque inicialmente sem método e posteriormente com o método ativado no 

procedimento de análise de dados.

3) Calibração da curva padrão com 9 pontos.

•	Reintegration List Dialog ( ) → clicar em Sample Type e selecionar 
Calibration para todos os padrões → na coluna Cal. Level, ordenar os 
padrões em sequência crescente (1; 2; 3) → em calibration coefficients, 
selecionar Clear Coefficients at Start of List12 → Calculate Results → 
aparecerá a pergunta: All calibration coefficients will be cleared - continue 
reintegration? Selecionar Sim (Figura 20).

•	Clicar em Results → View Calibration Curve → no tópico origin clicar em 
Ignore13 → Save → Edit Calibration Curve Dialog; aparecerá a pergunta: 
Write changed record to the file? Selecionar Sim  e clicar em Fechar ( ). 
Sem fechar a view Interactive Graphics, voltar para os comandos iniciais 
do segundo tópico para incorporar os pontos restantes (Figura 21), 
seguindo os procedimentos descritos a seguir.

12Deve-se excluir a curva padrão salva no método copiado para poder configurar a nova curva de 
análise que ficará salva e servirá de parâmetro tanto para às injeções efetuadas no momento da 
análise quanto para às integrações de dados. 
13Anotar o coeficiente de determinação R2 e a curva linear da análise estatística (External Standard 
Analysis) descrita na view calibration curve.
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Figura 19. a) Comandos de edição dos cromatogramas para integração cromatográfica 

dos pontos da curva padrão; b) Detalhe para os procedimentos e parâmetros de 

integração: Barra de simetria e linha de integração, ponto inicial e final do pico, linha de 

simetria para parâmetro de saturação de coluna e ícone de integração (reintegration now).



36 Passo a Passo para o Uso do Cromatógrafo Gasoso Modelo GC-CP3800 Varian para 
Análises de Gases de Efeito Estufa (GEEs)

Figura 20. Procedimentos para calibração da curva padrão analítica.
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Figura 21. View de calibração final de curva padrão com sete pontos e com nove pontos. 

Destaque para a curva linear e o valor de R2, referência de acuraria dos pontos inseridos 

na curva.

•	 Incorporar os dois pontos restantes para completar a curva de calibração. 
Para acrescentar os dois pontos restantes, devem-se repetir os 
procedimentos do segundo tópico Calibração da curva padrão (Integração 
dos cromatogramas dos padrões analíticos). Na view Open Mutiples Data 
Files, clicar em Clear All, selecionar os padrões restantes e continuar 
conforme os procedimentos do segundo tópico. Em seguida, efetuar 
a repetição do terceiro tópico da Calibração da curva padrão → view 
Reintegration List Dialog; clicar em calibration coefficients, selecionar 
Incorporate New Calibrations Into Data Set e continuar conforme os 
procedimentos do terceiro tópico (Figura 22).

•	Após a calibração, anotar as áreas dos pontos da curva. Na view 
Calibration Curve,  executar duplo clique em cima de cada ponto inserido 
na curva de calibração, aparecerão dados de área em mvolts sec-1 e 
concentração em ppm. Para finalizar e salvar a curva padrão, clicar em 
Fechar ( ) Interactive Graphics → na janela Save Modified Method clicar 
em Save14 (Figura 23).

14Efetuar os mesmos procedimentos repetindo o processo desde o início para todos os canais a serem 
analisados (Front=FID; Middle=FID; Rear=ECD). A opção de troca do canal é na view Select Method 
Data Handing Section apresentada no primeiro tópico da Calibração da curva padrão.
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4) Confirmação da curva padrão.

•	Após a execução das curvas padrão para os canais de análise, deve-se 
confirmar se as curvas criadas foram salvas com sucesso.

•	Para iniciar a análise das amostras de campo,clicar em View/Edit 
Chromatograms → abrir Interative Grafic; aparecerá a view Open Mutiplus 
Data File → Fechar → Clicar em File e ir em Open Method → Star; 
selecionar o método copiado [extensão. *mth] → Open para ativar → 
Select Method Data Handing Section e escolher o canal de identificação 
– detector (Front; Middle; Rear) → OK → Results; clicar em View 
Calibration Curve, verificar curva criada e fechar ( ) sem salvar → clicar 
em Fechar ( ) Interactive Graphics. Repetir os mesmos procedimentos 
para todos os canais em análise.

Início da injeção das amostras de campo
•	Após a calibração e confirmação das curvas padrão, retornar à planilha 

de amostras que já deve estar com as amostras digitadas (a planilha 
precisa ser sempre alimentada com uma amostra a mais para não fechar 
automaticamente) e continuar o processo de análise com as amostras  
de campo.

•	Retirar as amostras do refrigerador (≈4 °C), colocar na sequência da 
Samplelist e organizar próximo do aparelho em ordem de injeção. Dessa 
forma, deve-se retirar todas as amostras a serem efetuadas na bateria de 
análise do dia. As amostras devem ficar em ambiente com ar refrigerado, 
em temperatura estável, sem interferência de umidade.

•	Para prolongar a integridade dos septos dos frascos de coleta, utilizar 
agulha de transferência do tipo ultra fine, que deve ser empregada 
somente para a passagem da amostra dos frascos de coleta para a 
seringa. O furo no septo deve ser centralizado (Figura 24).

•	Cuidado com entupimento de agulhas. Devem-se fazer trocas e vistorias 
periódicas no material de análise: agulhas e septos dos frascos de campo.

•	Confirmar o método e verificar a mensagem Waiting no System Control 
→ abrir a Samplelist e observar um (x) ao lado da amostra a ser injetada. 
A amostra só deve ser introduzida no sistema se ao lado do nome estiver 
aparecendo o ícone de amostra atual (x). Quando forem selecionadas 
duas ou mais repetições de injeção (ocorre nos brancos) na mesma 
amostra, aparecerá ao lado do nome a quantidade crescente em números 
até chegar na última repetição, na qual aparecerá o (x) (Figura 25).



41Passo a Passo para o Uso do Cromatógrafo Gasoso Modelo GC-CP3800 Varian para 
Análises de Gases de Efeito Estufa (GEEs)

Figura 24. Organização das amostras de campo.

Figura 25. Planilha de análise cromatográfica ativada para injeção de amostras. Destaque 
para os procedimentos a serem verificados antes da injeção.
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Procedimentos para desligar o cromatógrafo GC ou 
ativar Standy by

1) Ativação do método desligar.

•	Fechar a Samplelist ( ). No System Control, ir em File → Activate 
Method → Activate a System Control Method File. Selecionar o método 
Desligar existente na pasta Star e clicar em Abrir; esperar equilibrar as 
temperatura para esfriamento do sistema (Figura 26).

2) Fechamento do sistema: software de automação, gases de arraste e 
modulo cromatográfico.

•	Fechar ( ) o software de automação Star Chromatography Workstation. 
Aparecerá a mensagem Shutting Down (Figura 27).

Na parte interna do laboratório, fechar as chaves dos gases interno 
e desligar o módulo cromatográfico. Na parte externa, desligar o 
compressor e fechar as válvulas de gases de arraste.

3) Ativação do método Standy by.

•	Em baterias analíticas extensas, adota-se o método standy by. Tal 
procedimento permite a utilização e manutenção da curva padrão 
calibração sem alteração das condições de análise e sistema.

•	Fechar a Samplelist ( ). No System Control, ir em File → Activate 
Method → Activate a System Control Method File. Selecionar o método 
Standy By Novo existente na pasta Star e clicar em Abrir; esperar 
estabilizar as temperaturas para esfriamento do sistema (Figura 28). 

•	Esperar esfriarem as temperaturas15, desligar as chaves internas do Ar 
sintético, Ar comprimido e Hidrogênio e manter todo o sistema ligado 
(módulo cromatográfico e computador). Na parte externa do laboratório, 
desligar o compressor e fechar os gases de arraste Ar sintético e 
Hidrogênio.

15No método Stand by, como o cromatógrafo GC não vai ficar em análise durante um tempo, 
os detectores são configurados com as temperaturas desligadas para não ficar aquecido sem 
necessidade. Mantendo-se assim a precaução de não danificar o aparelho por algum problema com os 
gases de arraste.
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Procedimentos de segurança e possíveis problemas 
(troubleshooting)

1) Gases de arraste.

•	Os cilindros de gás devem ser mantidos na parte externa do laboratório, 
em local sem umidade e luz. Certifique-se de que os cilindros estejam 
contidos firmes na posição vertical. Se ocorrer um acidente, o cilindro 
for derrubado e danificar a válvula, acontecerá uma explosão. Deve-se 
monitorar os reguladores de pressão para saber a quantidade de gás 
dentro do cilindro.

•	Pressão padrão (entrada no aparelho cromatográfico) verificada nos 
manômetros das chaves internas dos gases de arraste: Ar comprimido= 
500 Kpa; Ar sintético= 400 Kpa; Hidrogênio= 300 Kpa; Nitrogênio= 
500 Kpa; Hélio= 600 Kpa.

•	Não deixar o comatógrafo aquecer sem a passagem dos gases de arraste 
por causa de degradação de componentes internos do aparelho. Na 
Figura 29, pode ser visualizada uma indicação de não passagem de gás 
de arraste no sistema. Os sinais de automação not ready (aparelho não 
ativado para injeção da amostra), ready (aparelho ativado para injeção da 
amostra) e run (amostra em análise) ficam acionados ao mesmo tempo 
e todo o sistema trava. Ocorrendo isso, deve-se acionar o método Stand 
by e verificar, primeiramente, os gases de arraste e, posteriormente, o 
método configurado. 

Figura 27. Finalização do software de automação Star Chromatography Workstation.
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Figura 28. a) Método Stand by ativado com as temperaturas fora do equilíbrio;  

b) Temperaturas em equilíbrio do método Stand by. Detalhe para a indicação off  

dos detectores.
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Figura 29. Sinais de automação not ready, ready e run acionados ao mesmo tempo 

indicando algum problema no sistema. 

2) Controle da temperatura. 

•	Não alterar as temperaturas da configuração padrão de análise por causa 
de risco de degradação da coluna, volatilização da FE líquida, aumento 
da viscosidade dos gases de arraste e consequentemente menor vazão, 
não eluição da amostra. A temperatura deve ser mantida com exatidão e 
precisão de ± 0,1°C. 

•	A temperatura do forno da coluna tem que ser uniforme em seu interior e 
não pode ser afetada pela temperatura do injetor e detector.

3) Controle de umidade do ambiente e das amostras.

•	Verificar as datas de troca de pré-filtro e substituir em todas as análises 
o drierite do injetor. Os cilindros de padrão analítico devem passar por 
monitoramento e manutenção em válvulas e septos para evitar entrada 
de O2 e traços de H2O em engates e conexões. Verificar pressão do 
manômetro para controle de quantidade de gás interno.
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4) Fontes de problemas.

•	As principais fontes de ruídos são: erros do operador, contaminação nas 
amostras por falta de limpeza nos frascos de coleta, entrada de ar ou 
traços de H2O por ineficiência de septos, aterramento elétrico e sistema 
deficiente16, provocando alteração da linha de base, contaminação nos 
gases de arraste, impurezas acumuladas no detector e no sistema de 
fluxo de gases. 

5) Áreas e itens a serem checados.

•	Gases – pressões, velocidade linear, fluxo (no detector e injetor).

•	Temperaturas – coluna, injetor, detector, linhas de transferência.

•	Linhas dos gases e filtros – limpeza, vazamentos, expiração dos filtros.

•	Consumíveis do injetor – septos, liners, anilhas, drierite.

•	 Integridade da amostra – estocagem, limpeza do material de coleta, septo 
do frasco de coleta, procedimentos de coleta.

•	Seringas – técnica de manuseio, vazamentos, limpeza, agulhas.

•	Sistema de dados – ajustes e conexões.

Resultados analíticos

Edição e análise de cromatogramas – view / edit 
chromatograms ( )

Após a finalização da etapa analítica no cromatógrafo GC-CP3800 Varian, 
é necessário fazer a manipulação e edição dos cromatogramas gerados 
para quantificação da concentração do analito (ppm) em identificação. 

Na edição e análise de cromatogramas é possível: 

•	Alterar o modo de integração cromatográfica.

•	Obtenção do resultado de área (volts min-1 ou mvolts sec-1) do pico e 
concentração do analito (ppm).

•	Alterar parâmetros do método de integração (inibição de solvente, 
eventos de tempo, função zoom, etc.).

•	Obter a relação sinal/ruído.

16É indicada a existência de um circuito elétrico separado para o aparelho cromatográfico para não 
haver problemas de oscilação de corrente elétrica, amperagem e tensão do sistema.  
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•	Número de pratos teóricos.

•	Comparar cromatogramas.

•	Verificar simetria do pico: gaussian, tailing, leading.

1) Abrir os cromatogramas para análise de resultados. 

Para a execução da análise de resultados, segundo as configurações 
preexistentes no método analítico salvo, deve-se fazer a alteração de 
integração cromatográfica, função presente na Star Toolbar (Figura 30), 
com o método ativado.

Figura 30. Barra de ferramentas da Workstation Varian - Versão 5.0.

•	A partir da Star Toolbar (página de apresentação da Workstation), com 
o botão direito do mouse, selecionar Run Application (Figura 31) e View/
Edit Chromatograms ou  clicar no ícone ( ).

Figura 31. Comandos de entrada na view de edição de cromatogramas.

•	View/Edit Chromatograms → abrir Interative Grafic. Aparecerá a view 
Open Mutiplus Data File → Star → Data; abrir a pasta de amostras 
analisadas, selecionar os cromatogramas (sete no máximo) com um com 
um duplo clique no nome da amostra ou clique no nome do arquivo → 
Add To List Open File(s) → clicar em Channel e escolher o identificador 
de análise de resultados (Front=FID; Middle=FID; Rear=ECD) → Open 
File(s) (Figura 32). Em seguida, abrir o método. 
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Obs.: Ocorrendo algum problema na seleção do cromatograma em 
análise, deve-se clicar em File Names → Clear ou Clear All (Figura 33).

Figura 33. Comandos para desfazer a seleção de cromatogramas.

2) Abrir o método de análise de resultados. 

•	Clicar em File e ir em Open Method → Star; selecionar o método criado 
[extensão. *mth] → Open para ativar → Select Method Data Handing 
Section e escolher o canal de identificação - detector (Front; Middle; 
Rear) → OK; confirmar método ativado na parte superior da tela de 
automação (Figura 34). 

•	Clicar na barra de rolagem para mudar unidade de volts min-1 para 
mvolts sec-1 para poder executar a integração cromatográfica. Com a 
visualização do pico, colocar o mouse no centro do pico em análise e 
observar um quadro de informação no lado direito inferior da tela do 
computador (Figura 35).

3) Realizar integração cromatográfica 

Para obter os resultados de área e concentração do analito analisado, 
deve-se alterar as integrações cromatográficas. A linha de integração dos 
cromatogramas precisa ser posicionada tangenciando a linha de base. 
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Figura 34. Procedimentos de ativação do método de análise.

Figura 35. Procedimentos de mudança de grandeza para integração e análise de 

resultados.
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•	Após abrir os cromatogramas a serem integrados e o método para análise 
(o software precisa da curva padrão como referência para o cálculo de 
integração), clicar na barra de simetria do pico ( ) e ajustar 
colocando centralizada partindo do ponto inicial do sinal do pico ao ponto 
final. Efetuar o mesmo procedimento com a linha de integração  
( ); em seguida, clicar no ícone localizado na Star Toolbar → 
Reintegrate Now ( ) (Figura 36). 

Figura 36. a) 

Demonstração do 

ajuste da linha de 

base para integração;  

b) Picos integrados.
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Obtenção do resultado
•	Clicar no centro do cromatograma com o botão direito do mouse → 

View Results Only → Channel Front-Fid Results; escolher o canal de 
identificação – detector (Front; Middle; Rear) em Channel. Anotar em 
uma planilha a área (mvolts sec-1) do pico e a concentração do analito 
(ppm) observada no relatório de análise (Figura 37). 

Figura 37. a) Comandos para abrir a view de resultados; b) Relatório de resultado 

analítico da amostra.
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Elaboração de relatório de análise (standard reports)

O relatório de análise contém informações sobre o cromatograma 
analisado, podendo ser alterado em funções básicas de layout. 

•	Clicar com o botão direito do mouse no Start Toolbar; selecionar Run 
Application → Standard Reports ou clicar no ícone ( ) → Open Data 
File → Star → Data; abrir a pasta de amostras analisadas, selecionar os 
cromatogramas com um com um duplo clique no nome da amostra → 
Open File. Aparecerão duas views, uma referente ao cromatograma e 
outra ao relatório de análise (Figura 38). 

•	Para alterações no relatório de análise (título do relatório de análise, 
opções do cromatograma e opções do resultado), clicar em Options na 
barra de ferramentas, escolher as funções de opção de edição desejadas 
do Standard Reports para alterar e finalizar clicando em OK (Figura 38).

Descrição das funções de opção de edição do Standard Reports:

Report Title

•	Possibilita alterar o título do cromatograma analisado.

Chromatogram Format

•	Start Time e End Time: permite selecionar o intervalo de tempo de 
impressão do cromatograma.

•	Auto Scale: Enquadra automaticamente o maior pico do cromatograma na 
escala do papel. A Workstation estabelece automaticamente o valor para 
a Atenuação (Initial Attenuation) e para o Offset (Zero Offset). O valor de 
atenuação e Offset também pode ser estabelecido manualmente.

•	Length in Pages: permite selecionar em quantas páginas o cromatograma 
será impresso. A Workstation estabelecerá um valor automático para 
a velocidade do papel ou pode-se estabelecer um valor fixo para a 
velocidade do papel por meio de lnitial Chart Speed, desabilitando a 
função Length in pages.

•	Chromatogram Annotations: possibilita selecionar o que será visualizado 
no cromatograma, como Tempo de Retenção, Eventos de Tempo, 
Eventos do Cromatograma, Nome dos Picos e Linha de Base.

Results Format

•	Amount Units: permite dar nome à unidade de medida dos picos.

•	Number of Decimal Digits: possibilita estabelecer o número de casas 
decimais.

•	Run Documentation: admite selecionar o que será impresso no relatório, 
como Histórico da Corrida, Histórico de Erros, Relatório de Calibração, 
Histórico de Alterações e Notas sobre a amostra.
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Figura 38. Standard Reports e a função de opções para edição de relatório.
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•	Para converter os resultados em Ascii, encaminhar os dados do relatório 
no Word ou em uma planilha Excel e imprimir, clicar em File na barra de 
ferramentas (Figura 39).

Figura 39. Comandos para conversão do arquivo gerado em outros formatos (word  e 

excel) e impressão.

Outras funções que podem ser 
alteradas ou monitoradas

O programa de automação e análise cromatográfica Workstation Varian 
- Versão 5.0 possibilita monitorar configurações de acurácia de dados 
ou alterar qualquer parâmetro de análise e, posteriormente, reintegrar 
um ou mais cromatogramas.

1) Alteração de parâmetros de configuração. 

Set password (Configurar senha)

Method notes (Quadro de anotações do método)
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Integration parameters (Parâmetros de integração)

Peak table (Quadro de pico)

Time events (Eventos de tempo)

Calibration setup (Configuração de calibração)

Verification setup (Configuração de verificação)

Fill peak table (Alterar o quadro de pico)

•	 Interative Grafic → clicar em Edit Method → acesso às janelas da seção 
Data Handling do Método analítico. Depois de alterar qualquer parâmetro 
de análise, clicar em Results e ir em Reintegration List, selecionar a 
opção Clear Coefficients At Start Of List → Calculate Results Save 
Changes (Figura 40) ou Reintegrate Now ( ) (modificação de apenas um 
cromatograma).

Figura 40. Procedimentos para efetivar as alterações feitas nos parâmetros de análise.

2)  Adicionar eventos de tempo (alteração de parâmetro de integração).

Alterações de parâmetros de análise podem ser executadas para melhor 
obtenção dos resultados. Dessa forma, é possível incluir itens no 
método de integração utilizado.
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•	 Interative Grafic → clicar em Edit Method → Add Method Item; selecionar 
o evento a ser adicionado (Figura 41). Depois de alterar qualquer 
parâmetro de análise, clicar em Results, ir em → Reintegration List → 
selecionar a opção Clear Coefficients at Start of List → Calculate Results 
Save Changes ou Reintegrate Now ( ) (modificação de apenas um 
cromatograma).

Figura 41. Comandos para adição de eventos de tempo no método em análise.

Descrição dos tipos de eventos:

•	Add Peak Table Entry (Adicionar Entrada da Tabela de Pico – Barra de 
simetria amarela) .

•	Add Width (Adicionar Barra de Largura de Pico).

•	Add Integration Inhibit (Adicionar Linha de Integração de Inibição de 
Pico).

•	Add Sovent Reject (Adicionar Linha de Rejeição de Solvente).

•	Add Group Peak (Adicionar Linha de Integração de Pico Agrupado – 
Integração única).



59Passo a Passo para o Uso do Cromatógrafo Gasoso Modelo GC-CP3800 Varian para 
Análises de Gases de Efeito Estufa (GEEs)

•	Add Valley Baseline (Adicionar Linha de Base de Vale – Cria uma janela 
de tempo no qual todos os pontos de vale são forçados a comportar-se 
como pontos de referência para a integração do pico).

•	Add Forced Peak (Adicionar Linha de Integração de Pico – Linha 
Vermelha) .

•	Add Split Peak (Adicionar Barra de Divisão de Pico).

•	Add Horizontal Forwards (Adicionar Linha Horizontal de Integração para 
Picos Adiantados).

•	Add Horizontal Backwards (Adicionar Linha Horizontal de Integração para 
Picos Atrasados).

•	Add Horizontal Minimum (Adicionar Linha Horizontal de Integração para 
Picos Mínima Detecção).

•	Add Signal to Noise Ratio (Adicionar Barra de Sinal-ruído).

•	Add Tangent Percent (Adicionar Barra de percentagem de um pico 
referência em relação a um pico tangente).

•	Add Peak Reject (Adicionar Barra de Pico Rejeitado – Elimina picos muito 
pequenos a partir do relatório para garantir que os picos insignificantes 
não sejam confundidos com picos de interesse).

3) Parâmetros de monitoramento.

Para monitoramento é possível: verificar a simetria do pico; fazer 
comparações de cromatogramas [Verificação de tempo de retenção, 
linha de base, ruído, etc.] (Figura 42); verificar detalhes de um 
cromatograma por meio da função zoom; conferir números de pratos 
teóricos.

•	Para selecionar o zoom → manter pressionado o botão esquerdo do 
mouse e selecionar o cromatograma ou a parte onde vai ser feito o zoom 
(Figura 43). Para sair da função zoom, deve-se efetuar um duplo clique 
no cromatograma. Para sair do zoom, dar um duplo clique no mouse.

Obs.: Para mudar a cor dos cromatogramas clicar em View e ir em 
Preferences.

•	A verificação de números de pratos teóricos é feita na função Produce 
system suitability report. Clicar com o botão direito em cima do 
cromatograma → Produce System Suitability Report Open Method → 
Fechar ( ) → System Suitability (Figura 44).  
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Figura 42. a) Procedimentos para verificação da simetria do pico; b) Comparação de 

cromatogramas diferentes.
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Figura 44. Comandos para abrir a função Produce System Suitability Report.

Cálculos de concentração no Excel

Para calcular a concentração das amostras no Excel, deve-se obter os 
resultados de área e os valores de concentração dos padrões analisados 
na corrida de amostra. Os padrões analíticos possuem valores 
conhecidos, o que permite o cálculo de inclinação e interceptação 
(coeficientes a e b) da reta de regressão. 
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Como funciona no Excel

Os coeficientes da reta de regressão (inclinação e interseção) são 
utilizados para calcular a concentração do analito (Figura 45).

•	Concentração = (Área - β) / α

* Onde: Área é a área do pico integrado; β representa o coeficiente 
linear da reta de regressão (a interseção em y, ou seja, é o valor que 
y assume quando x for zero); α representa o coeficiente angular (é 
a inclinação da reta, mede o aumento ou redução em y para cada 
aumento de uma unidade em x) da reta de regressão. 

Figura 45. Tabela para cálculos dos coeficientes da reta de regressão.
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Possíveis problemas 

Erro de integração

Antes de integrar os cromatogramas é preciso ativar o método, pois dessa 
forma o programa de automação vai se basear na curva padrão, facilitando 
para o operador a visualização do início do sinal. Recomenda-se ter um 
parâmetro para integrar todos os picos de uma análise (Figura 46).

Figura 46. Procedimentos de integração cromatográfica.

•	Deriva na linha de bases (Drift) 

Pode ocorrer em razão da volatilização da FE líquida ou alternância de 
corrente elétrica (Figura 47). Não interfere diretamente no resultado, porém 
pode degradar componentes do aparelho, como a coluna cromatográfica.

•	Ruídos em cromatogramas

Os ruídos podem ocorrer em decorrência de vazamentos no sistema, 
entrada de ar ou umidade no sistema, frascos de coleta contaminados 
ou sujos, septos dos frascos com vazamento (Figuras 48 e 49). 
Tais problemas levam ao descarte da amostra analisada por erro de 
resultado de área e, consequentemente, de concentração.
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Figura 47. Demonstração de ocorrência de Drift.

Procedimentos de segurança 
importantes antes da coleta

•	Organização e limpeza do material de coleta: o material de coleta (frascos 
de coleta de amostras, septos, seringas, agulhas, bomba de vácuo, 
termômetros, pilhas, régua de mensuração, etc.) em laboratório deve 
passar por limpeza e monitoramento para substituição (se necessário).

•	Pesagem dos frascos: efetuar pesagem em balança analítica em 
laboratório até a estabilização (segurança de não entrada de ar e 
integridade de septo).

•	Verificação da bomba de vácuo: deve-se verificar a eficiência da pressão 
da bomba de vácuo e possíveis impurezas na mangueira e agulha.

•	Limpeza dos frascos e seringas: colocar os frascos em solução não 
eletrofílica por 24 horas, posteriormente, efetuar dois enxagues de 
lavagem e calcinação em mufla (500 °C/ 6 horas) para eliminação de 
compostos orgânicos. 

•	Eliminação de fatores de umidade: deve-se manter os frascos em estufa 
65 °C até serem fechados e monitorados em estabilização de peso. 
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Figura 48. Exemplos de cromatogramas com ruídos.
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Figura 49. Cromatogramas prejudicados por ocorrência de impurezas e ruídos.
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Coleta de amostras em campo

Para a determinação do fluxo de gás, as câmaras devem ser instaladas 
24 horas antes da coleta, com auxílio de um nível de pedreiro, suporte 
de madeira e porrete para fincar as bases no chão sem danificar. Se 
ocorrer presença de material vegetal vivo no local de instalação das 
câmaras, deve-se cortar na base do coleto da plântula sem danificar a 
raiz o que for encontrado na parte interna da câmara com uma tesoura 
(para não comprometer os espaços porosos do solo em avaliação). É 
necessário vedar a parte externa da lateral das bases das câmaras com 
solo compactado e não alterar o sistema instalado após o  
final do processo.

As coletas são realizadas 0, 10, 20 e 30 minutos após colocação 
da cúpula sobre as bases em seringas de polipropileno de 20 ml. 
Posteriormente, no momento da coleta, as amostras são transferidas 
para frascos de borosilicato de 14 ml com septos vacutainer. Antes da 
transferência das amostras, em campo, deve ser feito vácuo com uma 
bomba de vácuo manual em todos os frascos de coleta e o material 
amostrado tem que ser colocado sobre pressão nos frascos de coleta.

Os frascos precisam ser conduzidos refrigerados (≈ 4 °C) ao 
laboratório em que os teores de concentração dos gases serão 
quantificados.

Para monitoramento do experimento, é necessário coleta de dados 
de pluviometria local, temperatura do solo com termômetros de solo 
analógico, umidade e temperatura atmosférica com psicrômetro e 
umidade atual do solo (profundidade = 0–10 cm). 
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